A BioQUEST Library VII Online module published by the BioQUEST Curriculum Consortium

The BioQUEST Curriculum Consortium (1986) actively supports educators interested in the reform of undergraduate biology and engages in the collaborative development of curricula. We encourage the use of simulations, databases, and tools to construct learning environments where students are able to engage in activities like those of practicing scientists.

Email: bioquest@beloit.edu       Website: http://bioquest.org

Editorial Staff

Editor:             John R. Jungck     Beloit College
Managing Editor:    Ethel D. Stanley    Beloit College, BioQUEST Curriculum Consortium
Associate Editors:  
  Sam Donovan         University of Pittsburgh
  Stephen Everse     University of Vermont
  Marion Fass        Beloit College
  Margaret Waterman  Southeast Missouri State University
  Ethel D. Stanley   Beloit College, BioQUEST Curriculum Consortium
Online Editor:      Amanda Everse     Beloit College, BioQUEST Curriculum Consortium
Editorial Assistant:   Sue Risseeuw     Beloit College, BioQUEST Curriculum Consortium

Editorial Board

Ken Brown  University of Technology, Sydney, AU
Joyce Cadwallader  St Mary of the Woods College
Eloise Carter  Oxford College
Angelo Collins  Knowles Science Teaching Foundation
Terry L. Derting  Murray State University
Roscoe Giles  Boston University
Louis Gross  University of Tennessee-Knoxville
Yaffa Grossman  Beloit College
Raquel Holmes  Boston University
Stacey Kiser  Lane Community College
Peter Lockhart  Massey University, NZ
Ed Louis  The University of Nottingham, UK
Claudia Neuhauser  University of Minnesota
Patti Soderberg  Conserve School
Daniel Udovic  University of Oregon
Rama Viswanathan  Beloit College
Linda Weinland  Edison College
Richard Wilson (Emeritus) Rockhurst College
William Wimsatt  University of Chicago

Copyright © 1993 -2006 by Jeff Schank and William Wimsatt
All rights reserved.
Copyright, Trademark, and License Acknowledgments

Portions of the BioQUEST Library are copyrighted by Annenberg/CPB, Apple Computer Inc., Beloit College, Claris Corporation, Microsoft Corporation, and the authors of individually titled modules. All rights reserved. System 6, System 7, System 8, Mac OS 8, Finder, and SimpleText are trademarks of Apple Computer, Incorporated. HyperCard and HyperTalk, MultiFinder, QuickTime, Apple, Mac, Macintosh, Power Macintosh, LaserWriter, ImageWriter, and the Apple logo are registered trademarks of Apple Computer, Incorporated. Claris and HyperCard Player 2.1 are registered trademarks of Claris Corporation. Extend is a trademark of Imagine That, Incorporated. Adobe, Acrobat, and PageMaker are trademarks of Adobe Systems Incorporated. Microsoft, Windows, MS-DOS, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation. Helvetica, Times, and Palatino are registered trademarks of Linotype-Hell. The BioQUEST Library and BioQUEST Curriculum Consortium are trademarks of Beloit College. Each BioQUEST module is a trademark of its respective institutions/authors. All other company and product names are trademarks or registered trademarks of their respective owners. Portions of some modules’ software were created using Extender GrafPak™ by Invention Software Corporation. Some modules’ software use the BioQUEST Toolkit licensed from Project BioQUEST.
# Table of Contents

Modeling Tools User’s Manual ................................................................. 7
How To Use Logistic Growth and Blending Inheritance ............................ 7
What You Need To Know To Use These Programs .................................. 7
How To Use the Simulation Programs for Logistic Growth and Blending 7

Starting the Programs ........................................................................... 7
Running Simulation Experiments ............................................................. 7

**Logistic Growth**

- Entering Parameters for the $N$ vs $t$ and $N(t)\ vs\ N(t+m)$ Plot Modes in the “Initialize & Plot” Dialog Box: ................................................................. 9
- Data and Parameter Errors ................................................................... 11
- Scaling Graphs ..................................................................................... 12
- Running a Simulation ......................................................................... 13
- Interrupting a Simulation ................................................................. 14
- Plotting Mode Options: Size vs Time, and Phase Plots ......................... 14
- Plot Display and Interaction Options .................................................... 16
  - Plot K & C ........................................................................................ 16
  - Show Grid ......................................................................................... 17
  - Graph Coordinates .......................................................................... 18
  - Point Size ....................................................................................... 19
  - Patterns and Colors ....................................................................... 19
  - ReDraw .......................................................................................... 20
  - Get $N$ ............................................................................................ 20
- Horizontal and Vertical Legends ...................................................... 21
- Record Coordinates ........................................................................... 21
- Other Windows ................................................................................... 21
  - Help ............................................................................................... 22
  - Run Record .................................................................................. 23
  - Note Pads .................................................................................... 24
- $r$ vs $N$ Plots ....................................................................................... 24
  - Entering Parameters ....................................................................... 25
  - Blowups and Computational Time in $r$ vs $N$ Plots .......................... 26
  - Running a Simulation ..................................................................... 27
- $r$ vs $N_e$ Plots .................................................................................... 28
  - Entering Parameters ....................................................................... 28
  - Running a Simulation .................................................................... 29
- Transferring Plots to Other Programs .................................................. 31
  - Saving PICT Files ........................................................................... 31
  - Saving Text Files .......................................................................... 32
  - Opening PICT Files ........................................................................ 32
  - Opening Text Files as Notebooks .................................................... 33
- Printing Windows ................................................................................ 33
  - Quitting and Closing Windows ....................................................... 33
  - Copying and Pasting Graphs ............................................................ 33
  - A Note on PICTs and the Latent Powers of the ScrapBook .............. 35
  - Copying and Pasting Text ................................................................. 37
Modeling Tools

Windows Menu .......................................................................................................37
Font Menu................................................................................................................38

**Blending Inheritance** ..........................................................................................39
Entering Parameters ...............................................................................................39
Interpreting Plots .................................................................................................41
Plot Display and Interaction Options ..................................................................43
Saving Windows ....................................................................................................44
Opening Window ...................................................................................................44
Transferring Plots to Other Programs .................................................................44
Printing Windows .................................................................................................44
Quitting and Closing Windows .............................................................................44
Modeling Tools User’s Manual

The Modeling Tools module contains the simulation programs Logistic Growth and Blending Inheritance and is intended to accompany the Modeling module. The Modeling module can be found in the BioQUEST Collection folder on The BioQUEST Library CD.

How To Use Logistic Growth and Blending Inheritance

What You Need To Know To Use These Programs

We will assume that you are already acquainted with the Macintosh interface and the most basic terms and operations of the Macintosh operating system. If you are not familiar with these basic terms and operations, you should either refer to the Macintosh Owner’s Guide for help in using this manual, or find somebody to help you who is already familiar with the Macintosh. The terms that you will need to be familiar with are: menu, menu option, window, dialog box, text box, alert, icon, mouse, point, cursor, click, double click, button, radio button, check box, close box, and desk accessory. If you already know these terms, you should have no trouble using these programs (but even if you don’t, many of these terms are explained in the context in which they are used below).

How To Use the Simulation Programs for Logistic Growth and Blending Inheritance

Starting the Programs

To start either the Logistic Growth or Blending Inheritance programs, double click on the application icon you want to run. To double click an icon, move the cursor over the icon you want to run and click the mouse twice in rapid succession. The icons of these two programs are illustrated in Figure A1.

![Logistic Growth 2.0 and Blending Inheritance 2.0 icons](image)

Figure A1. The Logistic Growth and Blending Inheritance program icons.

Running Simulation Experiments

In this “How To” manual we will describe how to use two simulation programs to explore the ideas presented in the Modeling module. We will begin by describing the Logistic Growth program because it has a slightly more complicated...
interface than Blending Inheritance, and because many of the interface features in Blending Inheritance are similar to those in Logistic Growth.

**Logistic Growth**

The simulation program Logistic Growth provides the user with a number of ways to graphically analyze, interpret, and understand the behavior of the logistic growth equation (i.e., \( \frac{dN}{dt} = rN(1 - \frac{N}{K}) \)) and minimum density limited logistic growth equation (i.e., \( \frac{dN}{dt} = rN\left[\frac{(K - N)}{K}\right] \left[\frac{(N - C)}{N}\right] \)). There are three basic simulation options available under the **Menu** option **Simulation** (described below). These are “Initialize & Plot,” “**r** vs **N**,” and “**r** vs **Ne(t)**”. Data produced with the “Initialize & Plot” option can be viewed either as “**N** vs ti” plots or as “**N(t)** vs **N(t+m)**” phase plots. These two different suboptions will be described further below (and in the **Modeling** manual). The second major simulation option is “**r** vs **N**” plots. This option allows you to plot the behavior of population growth with respect to different values of the growth rate parameter **r**. Using the “**r** vs **N**” option, bifurcation plots can be generated (the normal use of programs of this type), as well as a variety of other things not so commonly studied. The third major simulation option is “**r** vs **Ne(t)**” plots. This option allows the user to plot temporal effective population size \( N_{\text{eff}}(t) \) with respect to different values of **r**, and connects logistic population growth to issues in population genetics (see the section on Logistic Growth in the **Modeling** manual). These plots are also usefully compared with the “**r** vs **N**” plots for some purposes. In addition, as discussed in the why to section on the Logistic Growth equations, the user can compare “exact” versus “approximate” equations for calculating effective population size.
Enetering Parameters for the N vs t and N(t) vs N(t+m) Plot Modes in the “Initialize & Plot” Dialog Box:

<table>
<thead>
<tr>
<th>Model Parameters</th>
<th>Simulation Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>$N_0 = 0$:</td>
<td>Change N by 5</td>
</tr>
<tr>
<td>$r$:</td>
<td>Change r by 0.2</td>
</tr>
<tr>
<td>$K = 0$:</td>
<td>Numerical precision: yes</td>
</tr>
<tr>
<td>$C$:</td>
<td>Round N</td>
</tr>
<tr>
<td>$\Delta t \geq 0.0025$:</td>
<td>1 ≤ iterations ≤ 10: 5</td>
</tr>
<tr>
<td></td>
<td>Generations (0 &lt; begin - end ≤ 400 * $\Delta t$):</td>
</tr>
<tr>
<td></td>
<td>begin at: 0 end at: 50</td>
</tr>
</tbody>
</table>

Figure A2. Dialog box for entering parameters for logistic growth model.

After selecting the “Initialize & Plot” option (see Figure A8 below), a dialog box will appear through which parameters and a specification of the simulation experiments to be run can be entered. Upon selecting “Initialize & Plot,” default parameters will appear as shown in Figure A2.

On the left side of the dialog box illustrated in Figure A2 the model parameters of the minimum density limited logistic growth equation are listed: the initial population size $N$ at the start of a simulation, population growth rate $r$, the Carrying Capacity $K$ of the environment for the population, and the minimum size $C$ of the population which can sustain growth.

The fifth parameter of this model is the change in time parameter called “$\Delta t$,” the default value of which is set at 1. The parameter $\Delta t$ must be set so that $\Delta t \geq 0.0025$, since one can’t do less than one generation; this value will generate 400 points in that one generation. When $\Delta t = 1$, this can be interpreted as reproduction occurring synchronously once each generation. As $\Delta t$ decreases, population growth becomes more like continuous growth over a generation. Increases in $\Delta t$ increase the time lag from when population size feeds back (through density-dependent effects) to affect growth rate. The further significance of this variable is discussed in the Modeling manual text for the minimum density limited logistic simulation.

---

1 Constraints on memory (and the desire to do up to 10 runs) limit the number of point plotted to 400 per run (see below), for a total of 4000 points per graph.
The right side of the dialog box in Figure A2 shows the simulation parameters. You can do as many as 10 simulation runs (a family of curves) at the same time by iteratively incrementing the starting value of either of the two crucial parameters, \( r \) or \( N \). You must first choose which parameter, and specify the amount by which it is to be incremented (or, if the value entered is negative), decremented in each successive run. Then you must choose how many runs to do. Select either “change \( N \) by” or “change \( r \) by,” by clicking on the corresponding radio buttons. When you initially open this dialog box, the radio button corresponding to “change \( r \) by” will be selected. If you select “change \( N \) by” then you will need to specify a value for the change in \( N \) for each successive simulation. Next select the number of simulations to be run successively. This is a whole number between 1 and 10. If you enter 1, then only one simulation will be run for the value of \( N \) entered (i.e., the initial value of \( N \) will not be incremented by the change in \( N \) value if 1 is entered). The same points hold if you select the “change \( r \) by” option.

There are two additional “check boxes” in the list of simulation parameters. Both of these are intended to allow you to study the effects of roundoff errors in calculations, though the latter option also allows one to do another interesting kind of simulation. (For further discussion, see the section on roundoff errors and finite automata in the second chapter in the Modeling manual (found in the BioQUEST Collection folder.)

By checking the box “Numerical Precision,” you can set the numerical accuracy of the calculations made during a simulation. This has the effect of rounding all quantities used in the calculation to the number of decimal places indicated, and reapplying this procedure each time an arithmetic operation (actually, only for \( x \) and \( \div \), which are the only two that can increase the number of places) is applied in the calculation of the equation. It is not applied for "housekeeping" functions (and thus is not used, for example, in the graphics routines). Numerical accuracy ranges from 0 to 6 decimal points. If numerical precision is not checked, the numerical precision of calculations is the numerical precision of the REAL numerical type in the Macintosh family of computers.

The other check box controls whether or not the value of \( N \) is rounded to the nearest integer value after the first generation--a move which might appear to increase the biological realism of the model, since we don’t have fractional numbers of organisms in the real world. If this box is checked, values of \( N \) are rounded; otherwise, they are not. This option has particularly interesting consequences which may not be apparent. See the relevant section (Roundoff Errors, etc.) referred to above.

Finally, the user can specify the number of generations that are plotted to the window. The settings in the dialog box above will plot generations 0 through 50. The only constraint on plotting is that the number of points plotted per run must be less than or equal to 400 (also see Scaling Graphs below). We have, for example plotted generations 50,000 through 50,400, though you will have to wait while the computer calculates the first 50,000 generations before you see anything. (And in that case, you’d probably be wise to set the number of runs to 1, only!)
Data and Parameter Errors

For the initial population density \( N \), and parameters \( K \) and \( C \) there are constraints placed on the numerical values which can be entered (this will also be true for all dialog box interactions with this program and the Blending Inheritance program). We have left it possible to put in values which don’t make biological sense, but there are mathematical and numerical constraints on the numbers that can be calculated which students should be made aware of. In particular, \( N \) and \( K \) should not be equal to zero. If these constraints are violated, a dialog box will appear which says that you have entered bad parameters and provide an appropriate message for correcting the error. For example, if “0” is entered for “\( N \),” then you will get a message which says that “\( N \) cannot equal 0” as shown in Figure A3.

There is also another kind of error which can occur when entering parameter values. This is the Bad Data error which occurs when a string of characters is entered which is not in the “format” of a number. Figure A4 illustrates a Bad Data error for the parameter “\( N \).” In this case ‘25A’ was entered which does not symbolize a number, and an alert box pops up with the message: “This string is not a number: 25A.” Of course, the far and away most common error of this type is to use the letter ‘o’ for ‘0’--and this catches it.
In either of these cases, you need to click on the OK button to proceed, after which you will be returned to the main dialog box with the offending entry highlighted as can be seen in Figures A3 and A4. If you decide to click on the Cancel button all values initially in the dialog box when you first selected the “Initialize and Plot” option will be restored. This will also be true for all dialog box interactions in both Logistic Growth and Blending Inheritance.

Scaling Graphs

At the bottom of the dialog box depicted in Figure A2, the user can specify the number of generations of population growth to be simulated. The starting generation can be any reasonably large number less than the stopping generation for a simulation. The only constraints are that the difference between the stopping and starting generations must be less than or equal to $400 \times \Delta t$ but greater than or equal to 1 as mentioned above, and that the maximum number of generations that can be entered into the stop box is: $2,147,483,647$. (Warning: if you enter such a large value you should be prepared to wait a long time—up to half a year or more on a Macintosh Plus computer—before it is done computing! These run times refer to how long it will take to compute the run, not to graph it. **You can, however, always interrupt a simulation when the beach ball cursor is on the screen by simultaneously pressing the Apple key and period—.**

---

2 on a MAC II, $N$ vs $t$ or $N(t)$ vs $N(t+m)$ plots are calculated at approximately 500 generations per second, plotted at approximately 200 generations per second with no lines, and at about 130 generations per second with lines. Rates are about $1/4$ of this on a MAC Plus or SE. Thus the maximum time a run should take you to plot is about 2 minutes ($400 \text{ points per run} \times 10 \text{ runs} = 4000$
Running a Simulation

When you are finished click on the OK button and a plot similar to the one illustrated in Figure A5 will appear after a few seconds of calculation (a spinning beach ball cursor will appear while the actual computation is occurring).

![N vs. time plot](image)

In Figure A5, the horizontal axis is time in generation units, and the vertical axis is the population size or density. The horizontal line about 3/4 of the way up this graph is the Carrying Capacity $K$, set here at $N = 100$. This figure shows 5 runs all starting at $N_0$ of 25, and lasting 25 generations for which the growth rate $r$, starts at 2.0 and is incremented by 0.2 in each successive run. (All of these values can be read off the legend at the bottom of the graph.) Each point on the graph represents the density of a population at a given generation time $t$. Different simulation experiments can be distinguished in this case because different patterns (filling the points, listed as run 1-5 in the legend on the right) represent different simulation experiments. Thus there are five patterns (black through 3 gray scales to white) and five simulation experiments. (See section on Patterns and Colors in Plot Display and Interaction Options below.) Points in this plot are connect by lines. If you can't see points at 30 points/second on a Plus.), assuming that the plotting has not been deliberately slowed down using the “redraw” option. Computing it is another matter, but we have found no reason so far to run single trajectories for more than 50,000 generations (800 seconds to calculate, and up to 12 seconds to plot on the Plus), or multiple trajectories for more than 1000 generations--or around 10,000 total generations (for 160 + 120 = 280 Plus-seconds) in one run. The $N$ vs $r$ and $N_{eff}(t)$ vs $r$ plots are an entirely different matter, since a standard run of a bifurcation plot may (though needn’t always) involve calculation of 120,000 generations and plotting 40,000--10 times as many as an $N$ vs $t$ plot with 10 trajectories, each calculating to generation 800 and plotting from generation 800 to 1200. See the relevant footnote below in the discussion of $N$ vs $r$ plots for more details on this.
the patterns, see "points" below under Plot Display and Interaction Options—it is likely either that your points are too small or that you have set the points for solid tones, rather than for patterns.

The two legends produced with this graph are optional, and can be turned on or off independently of each other. (Note that if you are using a color monitor, points will be in up to seven different colors; see below.)

**Interrupting a Simulation**

You will notice that when a simulation is running, a beach ball cursor, ![beach ball cursor](image), will be spinning. Whenever this beach ball cursor is spinning you can interrupt the simulation process by simultaneously pressing the apple key ( ) and the period key (.). Any simulation will be stopped and cannot be recovered. You can then start any new simulation you like.

**Plotting Mode Options: Size vs Time, and Phase Plots**

If you move the cursor to the Simulation menu (see Figure A8 below) and click and hold, you will see that there is a check mark ( ) that occurs before the option “N vs t” which means that this option is currently selected. This is the (population) Size vs Time option. The same data used to generate this plot can be used for another extremely useful kind of plot—the variable lag phase plot. Below the option “N vs t,” you will see this plotting option, here (more precisely) called “N(t) vs N(t+m)” which plots values of population size at time \( t \) (horizontal axis) versus values of that same population’s size at some later time \( t+m \) (vertical axis). This is basically a temporal auto-correlation plot of a variable \( N(t) \) with itself, \( m \) periods later. When you select this option, a dialog box will appear requesting a value for \( m \) as shown in Figure A6.

![Figure A6. Dialog box for entering the value of \( m \).](image)
The only constraints on the value of $m$ is that $m$ is a whole number greater than zero, and that $m$ is less than or equal to the number of generations times $\Delta t$. After you select a value for $m$, click on “OK” and a graph similar to Figure A7 will appear. (Note that for best results you should change the coordinates of the graph under this option so that the horizontal and vertical axes have the same pixel lengths as described below.) The check box “Show stability line” is set to be on by default, and controls whether or not the stability line is drawn. In Figure A7, the horizontal axis represents the population density at generation time $t$, and the vertical axis represents the population density at time $t + m$. In this case $m = 1$, so the vertical axis is labeled “$N(t+1)$.” The additional vertical line about 3/4 of the way down the horizontal axis is the Carrying Capacity, $K$, plotted for $N$ at time $t$. The diagonal line running from the lower left-hand corner of the graph to the upper right-hand corner is the “stability line,” so called because points which are exactly on it have the same value at $t$ and $t + m$. See the much fuller discussion of the use and significance of this type of plot in the section on phase plots in the "Advanced Topics" section of the chapter on the logistic in the full *Modeling* manual (found in the BioQUEST Collection folder.)

This kind of plot is normally drawn without the "lines" option, which produces a confusing welter of complexity. It is used here to indicate the one thing the "lines" option is good for in this mode: since (and this is generally true) the line between two points is drawn after the first point, and before the second, the part of it that covers over a point circle gives a vector representation of where the trajectory is going next. The patterns of migration are absolutely deterministic for a given set of parameter settings and lag-time ($m$), but can change significantly for changes in these settings, so using lines to give transition directions is often useful—and especially so in this plotting mode where the transition directions are often unintuitive. (Note on
phase plots and abstract art: While each of the plotting modes can produce a variety of informative and intriguing graphs, our own experience suggests that this plot mode, with lines, can produce a variety of quite pleasing and unfamiliar graphic effects. You might try experimenting with these!

**Plot Display and Interaction Options**

There are several options available for altering the display of a plot and interacting with it. If you click and hold on the **Simulation** menu (Figure A8), you will see that several options are available. All of these options are available for the $N$ vs $t$ and $N(t)$ vs $N(t+m)$ plot modes, but only some of them are appropriate for the other 2 modes. The remainder are grayed out in modes where they do not apply.

![Simulation menu options](image)

**Plot K & C**

Plot “K & C” (active for $N$ vs $t$ and $N(t)$ vs $N(t+m)$ plot modes) has a check mark () before it when initially opened up. This means that it draws in appropriate lines for the parameters $K$ (Carrying Capacity) and $C$ (minimum population density). If you select this option and the check mark is on, it will redraw the current plot without Carrying Capacity $K$ and minimum density $C$ plotted, and this option will subsequently appear unchecked in the menu list. If Plot “K & C” is not checked, then selecting this option will plot $K$ and $C$ and place a check mark before this menu option.
The option “Lines” is checked on when the program is started up. To turn this option off simply select it if it has a check mark in front of it. To turn this option back on, reselect it.

**Show Grid**

“Show Grid” (active for $N$ vs $t$ and $N(t)$ vs $N(t+m)$ plot modes) does not have a check mark before it when initially opened because showing the grid is not a default option. When you select “Show Grid” you will get the dialog box illustrated in Figure A9. If you want to show the grid, move the cursor over the show grid check box and click (to turn it off click a second time). The “Auto Scale Grid” check box indicates that you want to have the program automatically calculate a grid that fits the plot window each time you choose “Initialize & Plot.” When you do this, the vertical scale will automatically be 10% greater than the largest $y$-value plotted, and if “show grid” is selected, there will be 10 evenly scaled divisions between the $x$-axis and that point, or 11 divisions overall. The maximum vertical scale (printed to the left of the $y$-axis) will thus be 110% of the maximum value plotted, and the default $y$-axis division will be 10% of that value. Thus the maximum value plotted can be easily read off from the “show grid” dialog box by multiplying this value by 10. (If you want it, as you will for some exercises in the blending inheritance lab, be sure to record it before changing the $y$-scale.) Entering a value in “Change $x$-axis by” will cause (if “show Grid” is checked) a vertical line to be drawn every unit of the value entered along the $x$-axis. Thus, according to the dialog box illustrated in Figure A9, a vertical line is drawn every 2.5 generations. The “Change $y$-axis by” value will cause a corresponding change in the drawing of horizontal lines starting from the $y$-axis. Thus in this case, a horizontal line is drawn every 12.8892 units of population size. This strange value is a result of autoscaling, from which you can infer that the highest value reached was 128.892.

Figure A9 shows the result of autoscaling a grid for the phase plot option, for only in this case will the maximum $x$ and $y$ values be the same, producing the same default values for grid increments in the $x$ and $y$ directions. When autoscaling a grid with an $N$ vs $t$ plot, the program automatically divides the $x$-axis into 10 evenly sized intervals, each 10% of the range from $x$-min to $x$-max.

You can choose any values you like for the grid increments in $x$ and $y$ directions, and this can be very useful for detecting periodicities in the $N$ vs $t$ plot mode. (See the Advanced Topics section of the chapter on the logistic in the full *Modeling* manual.) You can also have **grid lines in only one direction** (horizontal or vertical). Although the program will not let you set the $x$- or $y$-axis increments to zero, if you set the grid increment for the lines you wish to suppress to a value which is off scale (e.g., if $y$-max is 128.892, as depicted here, then any number which is greater than 11 times the default value for the grid increment in the $y$-direction, or if they are different, greater than 10 times the default value in the $x$-direction) will not plot on the graph. (Thus, given the default value in A9 of 12.8892, any number of more than $11 \times 12.8892 = 141.7812$ entered in the appropriate box will eliminate visible grid lines in that direction.) Of course, you don’t have to calculate this. You can read it off the label on the $y$-scale (141.78 in figure A8), or, just eyeballing it, 150, (or 1000--it really is arbitrary) will clearly do as well.
The “Graph Coordinates” option (active in all modes) allows the user to resize the graph within limits specified in the graph coordinates dialog box illustrated in Figure A10. The coordinate system for a Macintosh window has its origin (i.e., $x = 0, y = 0$) in the upper left-hand corner. The $x$-axis increases positively to the left of the origin (as is customary) and decreases negatively to the right. But, the $y$-axis increases negatively as one move down from the origin and decreases negatively as one moves up (which may not be customary to you). When you initially open up Logistic Growth, the numbers in the coordinate text boxes are set to a standard size window for the size of screen you are using. That is, the values for “top” and “left” cannot be smaller than the values which initially appear in these boxes, and the values of “bottom” and “right” cannot be larger than 1024 pixels. (There are 72 pixels to the inch.)
Point Size

The “Point Size” option (active in all modes save r vs N) allows you to change the size and pattern of points as illustrated in Figure A11. The size of a point can range from 1 to 100 pixels, with the default size set for size 4. (Larger point sizes might be useful for better visibility in a large window with a very large monitor, (e.g., for classroom viewing) and also, with appropriate x-scaling for assessing random coverings.) Points can also be filled solid or with up to five patterns by selecting the corresponding radio buttons. If you are working on a Macintosh with a color monitor, multiple simulation trajectories will be printed in seven colors in a standard order in cyclic rotation (see below). Colors and patterns cycle independently, so that there are 35 possible combinations—more than enough for the maximum of 10 trajectories. Thus the same color-pattern combination never reappears on a color monitor, though the patterns will repeat on a black and white monitor, for trajectories 6-10. (Note that point size can also be used to set the width and pattern of lines that are plotted in the “r vs Ne(t)” simulations described below.)

Patterns and Colors

As mentioned in the last section, points can be displayed in patterns, colors, or both patterns and colors. There are five types of patterns which are determined by the percentage of pixels used to generate the pattern, i.e., for a black and white monitor the order in which patterns will appear in plots in this program is black (100% of the pixels are filled), dark gray (75%), gray (50%), light gray (25%), and white (0%). If you have a color monitor there are seven possible colors (including black) that can be displayed by this program. These colors are (in the order in which they appear in plots): black, red, magenta, yellow, green, cyan, and blue. (This is our best attempt to order the standard colors to fit the color spectrum, ordered from low frequencies to high.) If you have the patterns option on when you are using a color.
monitor, then patterns will be filled with the color selected (e.g., red with the gray pattern (i.e., 50% pixels are filled) will appear pink).

ReDraw

The “ReDraw” option (active for \( N \) vs \( t \) and \( N(t) \) vs \( N(t+m) \) plot modes only) allows the user to change the speed at which the plot is drawn to the window, as illustrated in Figure A12. You can choose a plot delay of between 0 and 10 where 0 produces the fastest and 10 the slowest redraw. The default value is set at 3. The value \( z \) entered causes a delay (which is essentially machine independent) of approximately \( z/60 \) of a second between the plotting of each point (plus of course the actual computation time the computer requires to plot a point). A word of warning: if you enter 10 and there are several thousand points to be plotted, this can take up to 10 minutes or more to complete. Redraw affects only plotting speed, not computation, and is intended for demonstration purposes. Varying plotting speed sometimes naturally leads to perception of different patterns in the data (see Wimsatt, 1991) and you may find it worthwhile to play with this option when you have a particularly intriguing data set.

![Figure A12. Plot Delay dialog box.](image)

Get N

“Get N” (active for \( N \) vs \( t \) and \( N(t) \) vs \( N(t+m) \) plot modes) allows you to enter an \( N \) value from a plot as an initial population size or density value in the parameter dialog box by clicking within the plot frame. This can occur when the cursor takes this form: \( \bullet \) and then by clicking the mouse the \( x \) and \( y \) coordinate values appear above the plot as can be seen in both Figures A5 and A7.\(^3\) You can move a value of \( N \) in the “\( N \) vs \( t \)” plot or a value of \( N(t+m) \) into the parameters dialog box by first selecting the “Get N” option from the Simulation menu (a check mark will indicate that this option is on), and then moving the cursor to the point desired and pressing the mouse button. If the “Get N” option is not checked the number selected will not

\(^3\)Note that these are only approximate values since pixel coordinates are transformed into generations or population level numbers and there will be round off errors in doing this—which should be no larger than \( 1/2p \) of the total range, where \( p \) is the number of pixels along that axis of the graph as specified in the graph coordinates box.
be transferred to the dialog box, but this can still be used effectively to read off values from the graph. (To record these data, see the Record Coordinates option below.)

**Horizontal and Vertical Legends**

Both the horizontal and vertical legends are checked on by default. Selecting either of these options allows the user to show or hide these legends, and to include them or not in a graph which is to be saved.

**Record Coordinates**

By default the record coordinates option is off. Choosing this menu option allows the user to record data points into the Run Record Window (see Figure A13). What is recorded is basically the current value of the $x$- and $y$-coordinates printed above the graph each time it is updated by pressing the mouse button. This enormously simplifies collection of data from graphs, and may be interspersed with commentary entered using the text editor features of the run record. See example in Appendix F below.

---

**Figure A13.** Record Coordinates into the Run Record Window.

---

**Other Windows**
All windows other than the plot window in both Logistic Growth and Blending Inheritance are text windows. All text windows in these applications are editable but limited in two ways. First, they can contain at most 32,000 visible and invisible characters. Second, only unformatted text can be placed in these windows (e.g., graphics cannot be put into these windows). The run record is a special kind of text window to which certain kinds of data (run parameters) are automatically sent, and to which other kinds of data may be manually sent (using the record coordinates option) and comments added. Three of these windows, the "help" notebook, the "bug comments" notebook, and the "run record" notebook are opened automatically when the program boots, so that they will be immediately accessible under the Windows menu. Up to eight other (text only) windows can be opened simultaneously, as long as each is less than 32K in size.

Help

- This basic "help" file is designed to be editable, so that you can customize it, and open and use it from within the program. To edit this file save it under another name, then reopen the saved file (using the Open command and dialog box in the File menu) and edit it using the commands in the Edit menu and the normal word processing commands (select, delete, return) to compose, insert, and delete text.

The maximum size of this file is 32K. We have left you some room to add your own text, even if you keep all of the standard help entries, but, since you will also have access to this standard help file, you may delete it all if you wish. (If you do so, then this file is no different than a standard Notepad.) Since you may open any standard "text only" document as a notebook, you may also compose your personal help file in any word processor, and then save it in "text only" mode to be opened by this program. (The program will usually open other text formats, but the text will show additional formatting characters, or be constrained in other ways--e.g., "text only plus line formatting" will not word wrap appropriately for different sized windows.)

The Help file contains minimal information to provide on-line help with what we believe to be the most likely problems for the neophyte user, with more information to be found here, in the Modeling Tools User's Manual. The information in the Help file includes:

- Entries for each menu item. These are organized by major menu headings (from left to right: "Apple," File, Edit, Simulation, Window, Font) and alphabetical within them. All other entries are included in an alphabetical list following the Menu Index.

- Entries for options in each dialog box. If you encounter problems with a dialog box, and are unsure how to go on, cancel the operation, consult this help document and/or the manual, and then proceed. (Of course, if you've already encountered this situation, we hope you did the right thing!)
Entries for any warnings you might encounter which are either special to this program or features of the Macintosh operating system which are of particular importance.

Other topics from the index of the manual which seem important. Consult it for further help.

* We plan in the future to include (probably in another NOTEBOOK) a STRATEGIC HELP facility, which will comment on particularly useful techniques for problem solving.

Capitalized terms in the text either occur as entries in this file (in the MENU section or the following ALPHABETICAL section) or refer to important operations in DIALOG boxes or elsewhere in the program. The MENU section follows the organization of the MENU BAR—giving the menus (bracketed by • • •) in sequential order (reading from left to right), with each menu followed by its choices (bracketed by • • if they lead to a submenu or dialog box allowing or requiring further choices, and bracketed by • if they do not).

Submenu options are preceded by '...' (complementing the '...' following the menu option used to get to them) and bracketed by •'s.

**Run Record**

This is the RUN RECORD notebook, which automatically records all of the information you will need for a complete record of your session with this software (see Figure A14 for a sample run record). This includes:

- All parameters necessary to generate the data of a run are entered as a multiline block, followed by a COMMENTS section. (A run occurs whenever you select "Initialize and plot" (for plot modes $N$ vs $t$ or $N(t)$ vs $N(t+m)$), "$r$ vs $N$" or "$r$ vs $N(e(t))$" from the Simulation menu, and close the resulting dialog box by using the "OK" command.)

- Any data which change the appearance of a graph (the status of the "plot K & C" and "lines" commands, and the "point size," "show grid," and "graph coordinates" dialog boxes) are entered as an additional line, modifying the data in the block.

- Any data collected using the "record coordinates" option is entered as a single line with the names and values of the $x$ and $y$ coordinates.

* (Planned): Any "save" operations, giving the file saved and the name it was saved under. (In a long session, if the files are saved under special names, it then becomes laborious to figure out which "standard" graph names (e.g., $N$ vs $t$ Plot 27) assigned to the sets of graph parameters when they are saved in the run record, correspond to which "special names" given these files as informative names when they are saved. This option will also give a record accessible without quitting the program of which graphs have been saved.)
This gives you a complete record of your work. The data from any runs you choose can then be copied (we recommend that you don't cut them, so that they remain here also) to any other notebook for further commentary or analysis. (Perhaps you want to include minimal comments here.)

Note that if you don't save this file, you won't have it when you quit the program, and if you leave this file on the machine, it will be modifiable, or deletable, by others. Therefore, we recommend that at the end of the day you save this file (which is an important part of your data) with your own name and or the date added--"Run record-Charles Darwin 2-13-1867", (or a shorter version of this, since this is too long for a filename) and take it with you. NOTE that if the system crashes, goes down, or is deliberately shut down before you save this file, it is gone, so save soon and often.

**Note Pads**

Note pads are additional text windows that you can make or open to record comments and information about simulations (up to 8 note pads can be open at the same time).

**r vs N Plots**

The "r vs N" menu option allows you to, among other things, generate bifurcation plots (see the section above on simple population growth models), and also to plot where the population is as a function of the starting value of N, and the value of r for a small number of generations at a time. (Indeed, you can do this for as little as 1 generation.)
Entering Parameters

When you select this option, you will see a dialog box for entering parameters like that in Figure A15. If we use "generations used" or "number of generations," we can use the same dialog box for N vs r and Net vs r.

The "r vs N" option generates a graph with population density N plotted on the vertical axis and values of the growth rate parameter r plotted on the horizontal axis. This simulation works by using the logistic growth equation described above and plotting N for as many generations as you like against different values of the growth rate parameter r. In Figure A15, you will notice that the first things asked for are begin r and end r starting values. These values set the bounds of the horizontal axis. Begin r is at the origin and end r is the right most value. Thus, in this case, we will plot values of r from 1.0 to 3.0. The number of values plotted along the horizontal axis is determined by the width in pixels of the graph. (You can determine how many values will be plotted by opening the Graph Coordinates Window and subtracting left from right, i.e., values plotted = Right – Left. The formula for incrementing r along the horizontal axis is \( r_{i+1} = r_i + \Delta r \), where \( \Delta r = \frac{(r-end - r-begin)}{(right - left)} \), and i indicates the \( i^{th} \) pixel starting from the origin of the graph.) For example, looking at Figure A15 above, we see that Left = 25, Right = 463 and r-end – r-begin = 3.0 – 1.0 = 2.0. Thus, in this case, \( \Delta r = \frac{2.0}{438} = 0.00456621 \) and \( r_{i+1} = r_i + 0.00456621 \).

You then need to enter minimum and maximum values for N to be plotted within. That is, only values of N that fall within these upper and lower limits will be plotted to the screen. In this case we would plot from 0 to 180. Next, you are asked
to enter values for the number of generations to simulate population growth (for
each value \( r_i \)). The value entered for “starting generation” specifies the generation
you want to start plotting values of \( N \) for (i.e., the program simulates generations up
to this value but does not plot them to the screen). In the case illustrated in Figure
A15, for example, we will start plotting values at generation 25 and then 50 more
generations of population growth will be simulated; each generation will be plotted
to the screen for a given value of \( r_i \). The dialog entry “Initial \( N \)” is the starting
population density, \( K \) is the Carrying Capacity, and \( C \) is the minimum sustainable
population density for each \( r_i \). According to the values in the dialog box, we will start
each population with a population density or size of 50, a Carrying Capacity of 100,
and a minimum density or number of 0.

**Blowups and Computational Time in r vs N Plots:**

Setting minimum and maximum values for \( N \) and \( r \) allows you to blow up any
region of interest to look at it in more detail. (The coordinates of the region can be
identified by clicking with the mouse as described in the “get \( N \)” utility, and recorded
and commented on in the “run record” using the “record coordinates” option, and the
text editing capabilities of the program.) In this way you can do successive
explorations at greater and greater magnification. Note, however, that if you blow
up the region vertically (choosing \( N\text{-min} \) and \( N\text{-max} \) closer), in order to keep the same
visual density of points, you will have to increase the number of generations plotted
proportional to the magnification, so large blowups in the vertical dimension add
computational time. There is no such slowdown for blowups in the horizontal
dimension (making \( r\text{-min} \) and \( r\text{-max} \) closer), since the program does 1 \( r \)-value for
every pixel on the horizontal axis, though of course, since the program does one \( r \)-
value for each pixel of graph width, changing the graph coordinates "left" and "right"
affects run length. (So shorter graphs take proportionately less time.)

By checking the “do color PICT” option, a color picture of will be generated
(using 8 colors), one color for each generation plotted. If more than 7 generations
are plotted, then the program will cycle through the same 7 colors (i.e., black, red,
magenta, yellow, green, cyan, and blue). Note that this option is very memory
intensive and that your computer may not have enough memory to complete it. If
there is not enough memory available to create a color graph, try quitting and
changing the memory available to the application by choosing “Get Info” and
increasing the amount of memory as indicated in Figure A15. A color picture will be
calculated without drawing it to the screen first. Only after it is calculated will it be
drawn to the screen.

Finally, by checking “Round \( N \)” the population size or density for each
generation is rounded to the nearest whole number.
Running a Simulation

Figure A17 is a bifurcation graph that resulted from running the parameter settings in Figure A15 (except that the starting generation was set at 100 and then 100 additional generations were simulated and plotted for each value of \( r_i \)) using Logistic Growth. These plots do take some time to generate (a minute to many minutes depending on the numbers you specified for the initializing and plotting generations, so the program allows you to interrupt plotting by simultaneously typing the Apple key and period -- . 4 . When you do an \( r \) vs \( N \) plot, all menu items except “Graph Coordinates,” “Initialize & Plot,” and of course “\( r \) vs \( N \) plot” will be grayed out. This is because these grayed out options have no function in \( r \) vs \( N \) plots. (Note: "\( r \) vs

---

4The time for a run is approximately proportional to \((\text{right} - \text{left})[\#\text{initialization generations} + \#\text{plot generations}], \text{with initialization generations taking slightly less time than plot generations. See estimates for times in footnote 2, above. For the blending inheritance simulation, the number of points plotted approximately doubles each generation, so, e.g., generation 10 takes as long as all of generations 1-9. (You should be able to figure out why after reading the discussion of the blending simulation in the full Modeling manual.)
Modeling Tools

N" plots are not automatically redrawn when you call up a dialog box, so make sure that you copy the graphs (if you want to save them) immediately after the program is finished plotting. See the section on Transferring Plots to Other Programs below for details on copying graphs.) You can use the Graph Coordinates option to resize the graph, but you will then have to choose the r vs N menu option again to replot the graph from scratch. Therefore, it is best to decide before plotting how big you want your graph to be.

Figure A17. r vs N bifurcation graph resulting from parameters in Figure A15.

r vs Ne Plots

The r vs Ne plotting option is a first simple step in connecting the population dynamics generated by the logistic growth and minimum density limited logistic growth equations with their underlying genetic consequences. The “Why To” aspect for generating plots of growth rate r versus the temporal effective population size Neff(t) (or Ne(t)) is described in detail in the section on the logistic growth equation in the full Modeling manual. In general the features of use and the computational time for calculating an r vs Ne plot are very much like that of the r vs N plots (the r vs Ne plots take somewhat longer), although you can learn quite different things from them—they are in fact quite complementary.

Entering Parameters

When you select this option, you will see a dialog box similar to that in Figure A18.
As you can see by comparing this dialog box with that for $r$ vs $N$ (Figure A15 above) you need much the same data—in fact, exactly the same data—for the two graph types. You are just going to do slightly different things with it. With the $r$ vs $N$ plots you need to specify the range of $r$ values for which you want to calculate the temporal effective population size $N_{eff}(t)$. In Figure A18, effective population size will be calculated for values of $r$ between 0.0 and 3.0. The values of $r$ are calculated as in the $r$ vs $N$ plots described in the last section. Similarly, as with the $r$ vs $N$ plots, you can specify the vertical range within which values of effective population size for a given value of $r$ is to be plotted. As described in the full Modeling manual, the effective population size is calculated over 1 or more generations and you can calculate the effective population size starting from any generation. Therefore, we allow you to specify the starting generation and the number of generations to be used for calculating effective population size. In Figure A18, we have decided to calculate effective population size from the initial generation 0 to generation 50. Finally, as with the $r$ vs $N$ plots, we need to specify an initial value for $N$, for $K$, and for $C$.

**Running a Simulation**

Figure A19 is an example of a plot produced using the parameter values specified in Figure A18. We should set the default point size for this option to 1, rather than 4.
As discussed in the *Modeling* manual section on effective population size and the logistic equation, both an *exact* and an *approximate* equation for effective population size are plotted. In Figure A19 there is no noticeable difference in the values produced by either the exact or the approximate equations, but as pointed out in the *Modeling* manual, deviations can occur in certain circumstances.

The exact equation is always printed with a solid black line and if you have a color monitor it will appear black as well. The default option for the approximate equation is to be plotted with the gray pattern option, and it will appear red on a color monitor. You can choose to plot both with solid lines and to change line widths by using the point size option described above. If you choose a point size of 4, as illustrated in Figure A13, then each line will be 4 pixels in width; a normal line is 1 pixel in width as illustrated in Figure A19. The pattern option is the default (unless you have changed for another plotting option). Choosing the “solid” option in Figure A13 will result in both the exact and approximate equation being plotted with solid lines.

There are again two legends associated with *r* vs *Ne(t)* plots, both of which are optional. The main thing to note about the horizontal axis is that “start Gen” means that population *Ne(t)* is calculated only starting from the specified starting generation, in this case generation 25. “*Ne(t)* plotted” means that from the starting generation, *Ne(t)* is calculated for then next 50 generations in this case. The vertical legend on the right indicates which line is associated with the “exact” and which is associated with the “approximate” equations for temporal effective population size.
Transferring Plots to Other Programs

Logistic Growth and Blending Inheritance allow the user to save a graph as a PICT (see note on PICTs below) type file which can then be opened in standard graphics handling programs SuperPaint or MacDraw. It also allows the user to copy and paste graphs into other programs such as MacWrite or Word.

**Saving PICT Files**

To save a graph as a PICT file, choose the **Save PICT as..** option from the **File** menu.

A dialog box will appear that requests a name for the picture. Type in a name in click “Save” as indicated in Figure A21.
Figure A21. Save as dialog box example.

The PICT document saved will look like the one depicted in Figure A20.

Saving Text Files

When working on a text file the user can save their work just as with saving graphs. In this case, however, the Save and Save as ... options under the File menu will be highlighted. The icon of a text file is illustrated in Figure A22.

Opening PICT Files

PICT files that the user has saved can be reopened within the Logistic Growth and Blending Inheritance programs. To do so, choose Open from the File menu and select the PICT file you want to open. Only one PICT file will be opened at a time. PICT files can be saved under a different name or printed, but they cannot in any other way be manipulated within these programs. PICT files can, however, be edited in several commercial graphics programs.
Opening Text Files as Notebooks

Text files no bigger than 32K can also be opened in Logistic Growth and Blending Inheritance. To open a text file, again go to Open from the File menu and select a text file. Text files can be edited in these programs, but if you prefer a different type font or size, or fancier formatting, you should use a commercial word processing or text editing program.

Printing Windows

To print windows to a LaserWriter or ImageWriter choose the Print Window option under the File menu. Note that you may first want to choose Print Setup in order to set the orientation of the graph on paper (vertical or horizontal) or to set the scaling factor to a different value. (The default is 100%, but we have deliberately allowed for the production of graphs up to 1024 pixels wide, which, if you have sufficient memory (especially for the graphs produced with \( r \) vs \( N \) plots), can be reduced and printed at higher pixel resolution on standard paper.)

If the window to be printed is a text window, the text will be automatically formatted and printed out in consecutively numbered pages in either 9 or 12 point Geneva font.

Quitting and Closing Windows

To quit Logistic Growth you can either choose Quit from the File menu or simultaneously press the Command key (\( \) ) and ‘Q’. The main graphics window cannot be closed (or resized in this version). However, any desk accessories that you open up can be closed by clicking on their goaway boxes or choosing the Close option form the File menu.

All graphics windows can be closed either by clicking in their goaway boxes or by choosing Close from the File menu. The Help, Run Record, and Bugs Windows are hidden and revert back to their default content (i.e., the content of these windows present when you first open these programs) when the goaway box is clicked on or the Close option is selected from the File menu. In all cases you are warned to save any changes you have made.

Copying and Pasting Graphs

After you have drawn a graph to the window, you will notice that both the Copy and Clear options are black and the rest of the options are gray (Figure A23). If you choose to copy a graph, a copy will be made that will be saved exactly as it appears in the window even when you quit the program.
It will often be convenient to use this program in conjunction with the desk accessory called the Scrapbook (look under the Apple menu; if it is not there consult the Macintosh Owner’s Guide or somebody familiar with the use and installation of desk accessories).

To use the ScrapBook to save plots for later use in writing up your results:

- First, size the graph using the Coordinates option under the Simulation menu to make the graph the size you want.

- Second, select the ScrapBook option under the Apple menu.

- Third, once the Scrapbook is open, you can use the Paste option under the Edit menu to paste the plot into the scrapbook. If you are trying to place the graphic in a particular place, the graphic pasted is placed right before the graphic which is showing. To place it last, you will have to place it in front of the last picture, and then cut and paste that in front of the new last one. Using the Scrapbook in this way is illustrated in Figure A24.
A Note on PICTs and the Latent Powers of the ScrapBook

Graphs made under the Initialize & Plot, $N(t)$ vs $N(t+m)$, $r$ vs $N$, and $r$ vs $Ne(t)$ options are saved in PICT format, which preserves color attributes (so you can make pictures to watch later on a color Macintosh, or to print on a color printer—even if the Macintosh or monitor you made them on was only black and white). These will print out much more crisply on a LaserWriter than on an ImageWriter or the screen, because they are constructed from mathematical functions rather than stored as bitmaps and printed at 300 dots per inch resolution. (The $r$ vs $N$ option is an exception here because there are usually far too many points—often 10,000 to 80,000—to store all of their locations easily, and they are stored as bitmaps, which saves on memory space.) Indeed this fact makes it possible to see a slideshow (particularly impressive in color) every time you open the scrapbook or a document which has these PICTs in it. It takes some time to draw the images, so the running of the program is recreated each time you view the PICT. (This can be used to your advantage in writing a report if someone is going to read it on a computer. Unfortunately, hard copy does not yet have this capability.) If you are going to make a slideshow designed for the scrapbook, be sure to size your graphics to fit in the scrapbook window. If the size is left constant, they will all be aligned in the same way. Motion pictures are also most usefully done for a series of PICTs which are the same in most variables, and varying in just one.
The scrapbook has several advantages for use with PICTs:

(1) It can hold a large number of items (we have dealt with scrapbooks with as many as 120 items in them, and a size approaching 2 megabytes). Thus, if you are going to paste a lot of PICTs into a word processing document, it is often more convenient to use the scrapbook than to save them as PICTs which have to be opened individually. Be warned, however, that you can make and paste a PICT into the scrapbook which is too large to paste into some applications.

(2) You can save scrapbook files of pictures which can be loaded on other computers. (Duplicate them from the standard scrapbook file in the system folder, give them another name, and take them with you. Rename the scrapbook on a computer you wish to use them with to something else, and rename your desired file "scrapbook file," placing it in the system file. When done, reverse the process and take it with you.)

(3) If you use Graph Coordinates from the Simulation menu to resize the graphs so they are totally visible in the Scrapbook, then you can depress the right and left "arrows" in the bottom scroll bar in the scrapbook to show "motion pictures" of series of PICTs. The speed of the "motion pictures" in all modes but $N$ vs $r$ in black and white is limited by how fast your computer can plot points to the screen and how many points you have per plot. (With a MacIIfx, for example, plotting rate for points ranges from 650-850/sec in the $N$ vs $t$ and $N(t)$ vs $N(t+m)$ plot modes, to 3500/sec in the color $N$ vs $r$ and $N(e(t)$ vs $r$ plot modes.) Something approaching motion picture speeds are attainable only for black and white PICTs in the $r$ vs $N$ mode, which in trials appear to present about 15 frames/second, independent of how many points are in each plot--a product of the fact that these, unlike the others, are stored as bitmaps. (Here the data presentation rate can be as high as 50,000 points/sec.) One caveat: virtual memory must be turned off for usable motion pictures--or maybe I should say, for pictures with usable motion.

For the size of the graphs to guarantee total visibility of all points within the boxed area, the differences between the appropriate graph coordinates should be no larger than Bottom - Top = 160, and Right - Left = 331. Since the default settings of Top and Left are 30 and 25, respectively, this implies settings of 190 for Bottom and 356 for Right. If you want to see the labels at the bottom and right, subtract 70 and 40 from these figures.

It is also worth noting that the scrapbook can save larger graphs than you can see in its window, so you don't have to crop them small enough to see them—unless you want to, as for a movie. A warning is in order, however: Graphs in PICT format can take a long time to print out on a LaserWriter that uses Postscript, because of the time it takes to convert the PICT QuickDraw commands into Postscript commands.

---

5 I have actually gotten presentation rates as high as 30 frames/sec., for black and white bitmaps with the scrapbook, but under conditions which are not yet reproduceable. Relevant variables include RAM size; cache allocation; preparation (by scrolling once through the pictures to load them all in RAM—it ia always slower when they are being loaded from disk); and whether virtual memory is activated. Presentation rate is both slower and becomes highly irregular with virtual memory on.
You can minimize this effect by plotting fewer points: use fewer runs, or avoid many generations (in Logistic Growth) or later generations (in Blending Inheritance). Alternatively, print them on a printer (ImageWriter or (paradoxically, usually cheaper) laser printer) which does not have Postscript, like the Apple IISC, or GCC Personal Laser Printer II. Finally, you can convert PICTs into bitmaps (which print much more quickly) by pasting them into MacPaint documents--at the cost of losing color and cutting resolution from 300 to 72 DPI (dots per inch). If you plan this latter course in advance, it is probably easier to use the "screen-dump" options supported within the Apple operating system: caps lock plus shift plus \( \text{} \) plus 3 or 4 save or print the whole screen and shift plus \( \text{} \) plus 3 or 4 to save or print the active window. The -4 direct print option works only with an ImageWriter, not a LaserWriter, and since these screen dumps print the frames of the windows in the second case, and the whole screen in the first case, both involve graphic material which you might want to erase in a paint program, if you care. The -3 option saves up to 10 images at a time--without exiting the program (numbered screen 0, screen 1, ..., screen 9) to disk as MacPaint documents which can be opened and worked on by most paint programs.

Graphs made under the \( N \) vs \( r \) option in Logistic Growth are saved as bitmap PICTs, so the resolution you see on the screen is the same resolution you will see when you print a bitmap PICT on an ImageWriter or LaserWriter. Note also that while you can observe runs with this option in color using a color monitor and in a color screen mode, saves in this mode must be done in black and white. (All other saves may be done in color, and in fact the PICTs are in color whether you produce them on a color or on a black and white Macintosh. Thus you can do them on a black and white monitor, and view them later in color, by copying the scrapbook or copying them into a Word Processing document where you can watch them go.

**Copying and Pasting Text**

Text can be copied or pasted from one text window to another by selecting the text to be copied and then choosing the **Copy** option from the **Edit** Menu, and then moving the text insertion point to the place in the window you want to past the text (see Figure A23).

When the **Copy Plot Parameters** option is highlighted, you can copy the plot parameters from the graph window and paste them into a text window such as a notebook.

**Windows Menu**

The **Windows** menu allows the user to select which window will be active. A check mark indicates which window is currently active (see Figure A25).
Font Menu

The Font Menu allows the user to change font size. Currently, only the Geneva font is available, in font sizes 9 and 12. When the font size is changed, the font for the whole window is changed to the font size selected. Text files are also printed out using the font size currently selected as indicated by a check mark.
The Blending Inheritance program shares many features in common with the Logistic Growth program, so only differences between these programs will be noted in this section. For shared options, refer to the last section on using Logistic Growth.

**Entering Parameters**

The parameters used for generating a binomial distribution model of blending inheritance are entered by selecting Initialize & Plot from the Simulation menu. As with the Logistic Growth program, a dialog box appears as illustrated in Figure A27. At the top of the dialog box illustrated in Figure A27, there is a box in which the frequency of character $x$ (e.g., red), $p$, can be entered. The only constraint placed on this frequency is that the frequency of character $x$ be greater than or equal to zero but less than or equal to one. The frequency of the alternative character (e.g., white) is automatically calculated as $q = 1 - p$.

Below this box, you are given two options: generate a binomial distribution or model blending inheritance. If you choose to generate a binomial distribution, click on the radio button next to “Binomial Distribution, trials” and then enter the number of trials represented in the binomial distribution you want to generate. If you choose...
to generate a blending inheritance distribution make sure that the blending inheritance radio button is selected and enter the number of generations of blending inheritance you want to depict. That is, you can enter the number of generations of blending inheritance you wish to observe. Entering a value of 1 in the start text box and 5 in the stop text box will generate binomial distributions for generations 1 through 5 as illustrated in Figure A28. The constraints on the parameters entered here are (a) stop must be less than or equal to 10, (b) start must be greater than or equal to 1, and (c) start must be less than or equal to stop. If you enter the same values for starting and stopping, then only that generation will be plotted.

![Figure A27. Dialog box for entering parameters for binomial distribution model of blending inheritance.](image)

![Figure A28. Example of the binomial distribution for f(x) = 0.5 from generation 1 to 5.](image)
There are again two legends associated with Blending Inheritance simulation plots. The bottom legend gives the values of $p$ and $q$ for the 0th generation. "Start Gen" and "Stop Gen" are the starting and stopping generations, respectively. The legend on the right of a Blending Inheritance plot gives the point color or pattern associated with each generation. The default pattern is solid for all generations but you can change this by selecting "patterns" in the Point Size option under the Simulation menu.

**Interpreting Plots**

**Binomial.** As can be seen from Figure A29, when Blending Inheritance is initially started up, the Binomial option under the Simulation menu is selected as indicated by a check mark. This will produce plots similar to the one depicted in Figure A29. The character $x$ is assumed to measurable on a scale ranging from 0 to 1. Thus, for example, if our initial characters are white and red and we assign 0 to white and 1 to red, then numbers between 0 and 1 are various shades of pink that become more like red in appearance as $x$ approaches 1 and more white in appearance as $x$ approaches 0. The vertical axis measures the frequency for a given value of the character $x$.

**Variance.** A distribution of the contributions of each character-class in the population to the total variance can be plotted by selecting the Variance option under
the **Simulation** menu. This will result in a plot that looks like Figure A30. The horizontal axis is the same as for the binomial plot, but the vertical axis now indicates the variance contribution of each character-class to the total variance in the population. Note that classes right at the mean contribute nothing, as one would expect.

![Figure A30](image)

**Figure A30.** Example plot of Variance contributions of characters in a population.

**Sum of Variance.** Figure A31 is an example plot resulting from selecting the **Sum of Variance** option under the **Simulation** menu. The **Sum of Variance** plot is the running sum of the individual variances, summed from character 0 to 1. Thus the sum of the variance at \( x = 1.0 \) is the total variance of the character in the population for a given generation. Similarly (in this graph) the sum of variance contributed by all terms from the left to and including the middle term (at \( .5 \)) = .0625. In this case the middle term contributes nothing—which happens whenever a point is exactly at the mean of the distribution and can be detected by a flat line segment to the left of the point.
**Sum of Binomial.** Figure A32 is an example plot of the sum of the binomial distribution resulting from selecting the Sum of Binomial option under the Simulation menu. The sum of the binomial distribution is the cumulative sum (starting at the left) of the frequencies of the individuals having different characters in a population, summed from character 0 to 1. Thus the sum of the binomial distribution at \( x = 1.0 \) is the sum of all the frequencies of characters in the population and is equal to 1.0.
The plot display and interaction options are the same as those for Logistic Growth except for the following. We have added a Standard Deviations option which allows you to place horizontal lines in the sum of binomial distribution plot where the standard deviations would occur for a normal distribution--reflecting the fact that binomial distributions with large \( n \) values are excellent approximations to the normal distribution. These are dotted horizontal lines at \( s = \pm 0.3416 \) and \( 2s = \pm 0.4772 \) for illustrating the normal approximation (see Figure A32). There are no “Get \( N’ \)” or “Plot K & C” options in Blending Inheritance. The auto scaling option is always on when the menu option “Show Grid” is selected (you can, of course specify your own grid for a given simulation, but if you run another simulation the program will automatically recalculate a grid for you).

**Saving Windows**

Follow the same procedure as described in the corresponding section for the Logistic Growth program.

**Opening Window**

Follow the same procedure as described in the corresponding section for the Logistic Growth program.

**Transferring Plots to Other Programs**

Follow the same procedure as described in the corresponding section for the Logistic Growth program.

**Printing Windows**

Follow the same procedure as described in the corresponding section for the Logistic Growth program.

**Quitting and Closing Windows**

See the corresponding section for the Logistic Growth program.
INDEX

Apple () menu .........................................34
Auto Scale Grid .........................................17
Bad Data ...................................................11, 12
bad parameters ..........................................11
beach ball cursor .......................................12, 14
beach ball cursor, will be spinning.
  Whenever this .i.beach ball cursor..14
begin ........................................................25
begin r .....................................................25
Begin r .....................................................25
bifurcation plots ...........................................8, 24
binomial distribution .....................................43
binomial distribution model ..........................39
bitmap PICT ...........................................37
BLENDING INHERITANCE 8, 12, 37, 41, 44
Blowups and Computational Time in r vs. N Plots..........................26
bottom ....................................................18
carrying capacity .......................................13, 16
change N by ...........................................10
change r by .............................................10
Change x-axis by ...................................17
Change y-axis by ...................................17
changing the memory available to the application ..........................................................26
check mark .............................................14
click the mouse ......................................7
Close ........................................................33
copy .........................................................33
Copy Plot Parameters ....................................37
Copying and Pasting Graphs .........................33
Copying and Pasting Text ...............................37
cursor ......................................................7
do color PICT ...........................................26
double click ............................................7
Edit menu ................................................34
end r .....................................................25
File menu ................................................33
Get Info ...................................................26
Get N .....................................................20, 26, 44
goaway boxes ..........................................33
Graph Coordinates .....................................18
grid lines in only one direction ..................17
Help file ...................................................22
icon ..........................................................7
ImageWriter .............................................37
Initial N ...................................................26
Initialize & Plot .........................................8, 9, 17, 35
Initialize & Plot .........................................8
Initialize and Plot .....................................12
interrupt a simulation ..................................12
K & C .......................................................16
left ...................................................18, 25
Lines ......................................................17
LOGISTIC GROWTH 7, 8, 12, 22, 31, 37, 39, 44
logistic growth equation ..........................8, 25
Logistic Growth equations ............................8
maximum value plotted ................................17
minimum density .......................................16
minimum density limited logistic growth equation ..................................8, 9
minimum population density .......................16
Motion pictures .........................................35
N vs. r .....................................................37
N vs. t .....................................................14
N(t) vs. N(t+m) ................................14, 35
Opening PICT Files .....................................32
Opening Text Files as Notebooks ....................33
Paste .........................................................34
patterns ...................................................41
patterns and colors ....................................19
personal help file ......................................22
Phase plots ...............................................14
phase plots and abstract art .........................16
PICT ....................................................35, 36, 37
pixels .........................................................18
Plot K & C ................................................44
plot window ...........................................22
plotting speed ........................................20
Point Size ...............................................19
population density ....................................15, 25
Postscript™ .............................................36
Printing Windows ......................................33
QuickDraw™ ............................................36
r vs Ne(t) ................................................30
r vs. N .....................................................8, 24, 25, 28, 29, 35
r vs. Ne ..................................................28
r vs. Ne(t).................................8, 35
Record Coordinates...........21, 23, 26
ReDraw..............................20
r-end....................................25
right.................................18, 25
Round N..............................26
roundoff errors and finite automata..10
Run Record.........................23, 26
Saving Text Files...............32
Scaling Graphs....................12
Scrapbook..........................34
Show Grid...........................17, 44
Simulation menu ..........34, 39, 41, 42, 43
Simulation menu (Figure A8).....16
Simulation menu (see Figure A8 below)...........................14
Size vs. time..........................14
stability line........................15
Standard Deviations...............44
starting generation...............26
Sum of Binomial....................43
Sum of Variance option under the Simulation menu ............42
temporal effective population size .8, 30
text windows..........................22
top......................................18
using lines to give transition directions
...........................................15
windows................................22